
Chapter 1Introduction to Computer Science 

What is Computer Science? 

 Computer science is a science that enables the automatic processing of information. 

o Science: Thus, it involves theories and models. 

o Information: Text, image, or sound (and even smells, tastes, and touch) 

represented in a form that can be manipulated by the machine based on its 

technology. 

 The term was created in 1962 by P. Dreyfus, "Société d’Informatique Appliquée." 

 Computer science refers to the automation of information processing by a concrete 

(machine) or abstract system. 

 Computer science (in English, computer science or computing science) is the study of 

the theoretical foundations of information and computation and their implementation 

and application with computers. 

Some Application Domains of Computer Science 

Where can computer science be applied? 

 Management Information Systems: Compatibility, invoicing, payroll, inventory and 

production system management, customer relationship management, banking and 

stock markets, decision support... 

 Industrial and Technological Computing: Computer-aided design and 

manufacturing, modeling and simulation of complex systems, embedded computing, 

telecommunications and networks... 

 Internet: E-commerce, information retrieval, security... 

 And also scientific disciplines, medical, human and social sciences, arts... 

Brief History of Computer Science 

 

 

2- Evolution of Concepts 



 

3- Evolution of Techniques 

 

But how does it work? 

Chapter 2 

1. WHAT CAN A COMPUTER DO? 
o A computer can process information. The computer is a tool that helps us solve 

certain problems. 

2. WHAT IS A COMPUTER? 
o A computer is a very powerful device that processes information (data) in 

binary form at very high speeds, with a high degree of accuracy, and has the 

ability to store all this information. The computer is divided into two parts: 

hardware and software. 



o A computer is an electronic device that processes information according to 

predefined sequences of instructions or programs. It interacts with the 

environment through peripherals (screen, keyboard, modem...). 

o A computer consists of electronic circuits that allow data to be manipulated in 

binary form, or bits. 

 

Hardware: The Components of a Computer: 

1. Introduction: A computer is a complex system capable of performing various tasks. 

To achieve this, it consists of a set of hardware and software elements. The first are 

the physical components of a computer: some of these hardware elements are used for 

the majority of operations, while others are more specific to certain types of tasks. 

2- A Desktop Computer: is designed to stay in one place, usually on a desk. It consists of: 

 A "central unit," also called a "tower." This contains the main components of the 

computer. It is also where you will find the power button: 

 A screen: which allows you to display the computer's content. 

 A keyboard: which allows you to communicate with the computer by typing text. 

 A mouse: which allows you to move the cursor on the screen. 

 Other elements can be added, called "peripherals." 

 

3- Other Types: 

 "All-in-one" computers. 

 Laptops. 

 Tablets. 

 



 

 

Hardware & Software 

A computer consists of two parts: 

 Hardware: Hardware refers to the physical components that make up desktop 

computers, PCs, and external devices. 

 Software: Software is a program and application that runs on a computer. 

Hardware 

 Motherboard: The motherboard is the central component of the computer. 

 

 Processing Units: 

o CPU - Central Processing Unit 

o GPU - Graphics Processing Unit 



 

 

Different Types of Memory for Different Uses: 

 ROM (Read Only Memory): Non-volatile memory 

 RAM (Random Access Memory): Volatile memory 

 

Hard Drive: Non-volatile memory 

 

Peripherals: 



 External Components: 
o Home Computer: Screen, mouse, printer, scanner, modem, ... 

o On-board Computers: Sensors, actuators, ... 

o Phone: Antenna, receivers, ... 

 Internal Components: 
o It's possible to add: 

 Internal hard drives 

 Drives, ... 

Chapter 3 : Operating System 

TP Office Automation (Practical) 

1. Operating Systems 

Introduction to Operating Systems 

An operating system (OS) is the software that manages all of the hardware and software on a 

computer. It provides a stable, consistent way for applications to deal with the hardware 

without having to know all the details of the hardware. 

How to Start Using an Operating System 

To start using an operating system, you need to: 

 Power on your computer. 

 The operating system will automatically load and present you with a login screen (if 

applicable). 

 Enter your credentials (username and password) to access the desktop environment. 

Operating System Elements 

 Desktop: The primary user interface that includes icons, windows, and menus. 

 Taskbar: A bar at the edge of the display showing open and pinned applications. 

 Start Menu: Provides access to installed applications, settings, and power options. 

 File Explorer: A tool for browsing and managing files and folders on your computer. 

 Control Panel/Settings: Allows you to configure system settings and control 

hardware. 

Command Buttons and Tools 

 Start Button: Opens the Start Menu. 

 Task Manager: Monitors and manages running applications and system performance. 

 File Explorer: Navigates and organizes files and folders. 

2. Windows 



Introduction to Windows 

Windows is a series of operating systems developed by Microsoft. It is designed to run on 

personal computers (PCs), tablets, and other devices. Windows provides a graphical user 

interface (GUI) that allows users to interact with the system using visual elements like 

windows, icons, and menus. 

How to Start Using Windows 

To start using Windows, you need to: 

 Turn on your computer and allow Windows to boot up. 

 Log in with your user credentials if prompted. 

 Once logged in, you will be presented with the Windows desktop. 

Windows Elements 

 Desktop: The main workspace that contains shortcuts to applications, files, and 

folders. 

 Taskbar: Located at the bottom of the screen, it shows open applications and provides 

quick access to other features. 

 Start Menu: Access installed applications, settings, and power options. 

 File Explorer: Manages files and directories. 

 System Tray: Contains icons for system and application notifications. 

Command Buttons and Tools 

 Start Button: Opens the Start Menu to access programs and settings. 

 Search Bar: Allows you to find applications, files, and settings. 

 File Explorer: Organizes and manages files and directories. 

 Control Panel/Settings: Configures system settings and hardware. 

Chapter 4 : Microsoft OFFICE WORD 

1. Introduction to word 

Word is a word processing software that allows you to create all types of professional 

documents, such as letters, reports, and dissertations. With Word, you can: 

 Edit. Word offers many features that allow you to quickly modify the text of a 

document. You can add or delete text, reorganize paragraphs, and check spelling and 

grammar. Word remembers the latest changes made to a document, allowing you to 

undo modifications you regret. 

 Format. You can format a document to enhance its presentation. It is possible to use 

different styles, sizes, and colors of fonts to highlight important text. You can also add 

page numbers, change margins, and use bullets to distinguish elements of a list. 

 Start Tables. Tables allow you to clearly present data in a document. You can 

improve their appearance with Word's predefined table templates. 



2. Starting Word 

To start the Word software, you need to: 

 Click on the Start button on the taskbar of Windows XP. 

 Navigate to All Programs in the Start menu. 

 Click on Microsoft Office Word 2007. The Microsoft Word screen will then appear. 

 

  Button 

  Quick Access Toolbar 

  Tabs 

  Command Groups 

  Minimize, Maximize, and Close Buttons 

  View Modes 

  Zoom 

  Status Bar 

  Horizontal Ruler 

  Vertical Ruler 

 Workspace 



Word Window 

The Word 2007 window contains many elements dedicated to creating and modifying 

documents, taking the form of a ribbon. The ribbon contains tabs organized around specific 

objects. On each tab, commands are organized into several groups. The ribbon can contain 

more comprehensive content than menus and toolbars, including buttons, galleries, and dialog 

box content. 

 

 

 

 

Tabs: Area for accessing command groups (Home, Insert, Page Layout, References, 

Mailings, Review, and View). 

 Command Groups: Areas containing command buttons and menus. Each tab 

contains several groups, for example, the Home tab includes: Clipboard, Font, 

Paragraph groups, etc. 

 Command Buttons: Allow you to execute an action. Each group includes command 

buttons and command menus (drop-down arrows that open a menu of options, e.g., 

Bullets, Numbering, Line Spacing, etc.). 

 Dialog Box Launchers: Small icons that appear in some groups, allowing you to open 

a dialog box with additional options. 

tabs 

Command group 
Control buttons 

Dialog lunshers  
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Word 2007 Toolbars 

Initially, Word 2007 displays only one toolbar: the Quick Access Toolbar, which is located 

at the top of the Word window. It allows you to quickly access the tools you use frequently. 

 

You can customize the Quick Access Toolbar by adding commands, either by: 

 Adding new icons: 
o Click on the arrow at the far right end of the Quick Access Toolbar. 

o Check or uncheck the option of your choice. 



 

 

 

 

 

  

Adding a New Command: 

 Click on the arrow of the Quick Access Toolbar. 

 Select the option More Commands… 

 Click on the drop-down arrow in the area: Choose commands from the following 

categories and choose a category. 

 Select the desired command from the drop-down list. 

 Click on the Add >> button. The command is added to the proposed list. 

 Click OK. 



 

 

 

Word 2007 Display Modes 

There are 5 document display modes: 

 Print Layout: Default mode, it displays the document as it will be printed. 

 Full Screen Reading: The ribbon disappears, and the document is displayed in "full 

screen" mode for easy reading. To exit this mode, click the "Close" × button at the top 

of the window. 

 Web Layout: Mode designed for creating web pages (HTML). 

 Outline: Mainly used in a long document, it allows you to see the sequence of 

headings and subheadings and also modify the structure. 

 Draft: This mode allows you to scroll through the document more quickly. Certain 

elements of the document, such as headers, footers, and images, are hidden. 

To switch from one display mode to another: 

 Under the View tab in the Document Views group, click on the desired mode; 

 Or click on the display mode icons located in the status bar. 



 

Getting Help 

To get help in Word for completing a specific task, press the F1 function key or click on the 

button        (located at the top right of the Word 2007 window). When the help 

dialog box appears, type in what you would like to do, then click the Search button. A list of 

topics related to your search will appear. Click on the topic of your choice to get explanations. 

Exiting Word 2007 

Before exiting Word, make sure you have saved your document, then: 

 Click on the Office button to open the Office menu. 

 Click on Close. 

FIRST STEPS WITH WORD 2007 

Entering Text: Word allows you to quickly and easily enter text into your document. The 

typed text will appear where the insertion point is blinking on the screen: 

 Type the text of the document. When you reach the end of a line, Word automatically 

continues the text on the next line. Press Enter only when you want to start a new 

paragraph. 

 Word automatically underlines misspelled words in red and grammatical errors in 

green, but these underlines do not appear in the printed document. 

Selecting Text: Most tasks in Word require you to first select the text you want to work on. 

The selected text appears highlighted on the screen. There are three methods for selecting 

text: 

 Click and Drag: Point the mouse pointer at the first character and drag the pointer 

over the text to select it. 

Selecting Text Based on Its Nature: 

 A word: Double-click on it. 

 A line: In the left margin, click in front of the line (in the left margin, the mouse 

pointer becomes   a rightward arrow ). 

 A sentence: Press and hold the Ctrl key and click on the sentence. 

 A paragraph: In the left margin, double-click in front of the paragraph, or triple-click 

inside it. 

 A block of text: Click at the beginning, then press and hold the Shift key, and click at 

the end. 



 The entire document: Press and hold the Ctrl key, then press the A key. 

Select Button on the Ribbon: It is also possible to use the "Select" button located on the 

Home tab, in the Editing group. 

To deselect text, click outside the selected area. 

Navigating a Document 

Depending on the length of your document and what you want to do, you may just want to 

"scroll" through the document (leaving the insertion point in place) or "navigate" within the 

document (moving the insertion point). The blinking line on the screen, called the insertion 

point, indicates where the typed text will appear. 

 Scrolling through the document (the insertion point stays in place): 

o Mouse wheel; 

o The vertical scroll bar. Drag its slider (page numbers and headings are 

displayed), or click the up ▲ or down ▼ arrow. 

 Navigating within the document (the insertion point moves): 

o Click on one of the double arrow buttons located below the vertical scroll bar 

to go to the previous page or the next page. The insertion point is positioned at 

the top of the page. 

o The 4 arrow keys on the keyboard (Direction keys): → ← ↑ ↓ 

o Keyboard shortcuts: 
 Word: To move to the beginning of the word: Ctrl+ ← ; to the end of 

the word: Ctrl + → 

 Line: To move to the beginning of the line, press: Home; to the end of 

the line, press: End 

 Paragraph: To move to the beginning of the current or previous 

paragraph, press: Ctrl + ↑ ; to the beginning of the next paragraph: Ctrl 

+ ↓ 

 Document: To move to the beginning of the document: Ctrl + Home; 

to the end of the document: Ctrl + Fin 

3. Document Manipulations 

Saving a Document You can save a document to keep it for future use. This allows you to 

consult and modify it later. It's important to regularly save the changes you make to your 

documents to avoid losing your work. 

To save a document: 

 Click on the Save button in the Office menu, or on the Save icon on the toolbar. The 

Save As dialog box appears. 



 

 

 

 Enter a name for the document in the File Name field. 

 Select a file type in the Save as type field. There are 2 types of Word documents: 

o Word 97-2003 Document (.doc):* Old format for Word documents from 1997 

to 2003. 

o Word Document (.docx):* New format for Word 2007 documents (not 

compatible with Word 97-2003). 

 Select a folder in the Save in field. The My Documents folder is selected by default. 

 Click Save. Word saves the document. 

Note: If the Save function is used again (for the same document), the Save As dialog box 

does not open because the document is already present on the disk. The document on the disk 

is updated with the changes made since the last save. 

Opening a Document: You can open a saved document and display it on the screen for 

review or modification: 

 Click Open in the Office menu; the Open dialog box appears. 

 Select the folder containing your document (My Documents folder is selected by 

default). 

 Click on the document to open it. 

 Click Open. The document opens and is displayed on the screen. You can review and 

modify it. The name of the open document appears in the title bar. 



 

 

 

 

 

 

Creating a New Document: 

To create a new document: 

 Click New in the Office menu. The New Document dialog box appears. 

 Select the desired template from the drop-down list (Word 2007 offers several 

document templates, including installed and online templates). 

 Click Create. A new document will be displayed in a separate Word window, and a 

new button corresponding to the new document will appear in the taskbar. 



 

 

 

 

Previewing a Document Before Printing 

You can use the Print Preview function to see how your document will look when printed. 

This function helps you ensure that the document will print exactly as you want. 

 Click on the Office button, in the Office menu hover over Print, a sub-menu will 

open, then click Print Preview, the Print Preview window will appear. 

 If the document has multiple pages, you can use the scroll bar to view the other pages, 

or the Next Page and Previous Page buttons in the Preview group. 

 To zoom in on the page, place the mouse pointer over it. The pointer will take the 

form of a magnifying glass. Click on the page for an enlarged version of the 

document. 

 To return to the full page view, click anywhere on the page. 

 To close the preview window, click on the Close Print Preview button. 



 

 

 

Printing a Document 

You can print a paper version of the document displayed on the screen. Click anywhere in the 

document you want to print. To print just a selected block of text, select it first; 

 Click on the Office button, in the Office menu hover over Print; 

 Click on Print. The Print dialog box appears; The Quick Print button allows you to 

send the document directly to the printer without making any changes. 

 Click on the desired print option in the Page Range area: 

o All: Prints all pages of the document; 

o Current Page: Prints the page where the insertion point is located; 

o Pages: Prints the specified pages. 

Selection: Prints the selected text; 



 Click on OK to start printing. 

 

 

 

 

Chapter 4 : Microsoft OFFICE EXCEL 

1. Introduction to Excel 

Excel is a spreadsheet software that allows you to create and manage all types of data-driven 

documents, such as financial reports, budgets, and data analyses. With Excel, you can: 

 Edit: Excel offers many features that allow you to quickly modify the data in a 

spreadsheet. You can add or delete cells, rows, and columns, and use functions to 

manipulate data. 

 Format: You can format a spreadsheet to enhance its presentation. It is possible to use 

different styles, sizes, and colors of fonts, as well as borders and shading to highlight 

important data. 

 Create Charts: Charts allow you to clearly present data graphically. You can improve 

their appearance with Excel's predefined chart templates. 

2. Starting Excel 

To start the Excel software, you need to: 

 Click on the Start button on the taskbar of Windows XP. 



 Navigate to All Programs in the Start menu. 

 Click on Microsoft Office Excel 2007. The Microsoft Excel screen will then appear. 

Excel Window 

The Excel 2007 window contains many elements dedicated to creating and modifying 

spreadsheets, taking the form of a ribbon. The ribbon contains tabs organized around specific 

objects. On each tab, commands are organized into several groups. The ribbon can contain 

more comprehensive content than menus and toolbars, including buttons, galleries, and dialog 

box content. 

 Tabs: Area for accessing command groups (Home, Insert, Page Layout, Formulas, 

Data, Review, and View). 

 Command Groups: Areas containing command buttons and menus. Each tab 

contains several groups, for example, the Home tab includes: Clipboard, Font, 

Alignment, etc. 

 Command Buttons: Allow you to execute an action. Each group includes command 

buttons and command menus (drop-down arrows that open a menu of options, e.g., 

Sort & Filter, Find & Select, etc.). 

 Dialog Box Launchers: Small icons that appear in some groups, allowing you to open 

a dialog box with additional options. 

Excel 2007 Toolbars 

Initially, Excel 2007 displays only one toolbar: the Quick Access Toolbar, which is located 

at the top of the Excel window. It allows you to quickly access the tools you use frequently. 

You can customize the Quick Access Toolbar by adding commands, either by: 

 Adding new icons: 
o Click on the arrow at the far right end of the Quick Access Toolbar. 

o Check or uncheck the option of your choice. 

Adding a New Command: 

 Click on the arrow of the Quick Access Toolbar. 

 Select the option More Commands… 

 Click on the drop-down arrow in the area: Choose commands from the following 

categories and choose a category. 

 Select the desired command from the drop-down list. 

 Click on the Add >> button. The command is added to the proposed list. 

 Click OK. 

Excel 2007 Display Modes 

There are several spreadsheet display modes: 

 Normal View: Default mode, it displays the spreadsheet in a regular grid format. 

 Page Layout View: This mode shows how the spreadsheet will look when printed, 

with margins, headers, and footers. 



 Page Break Preview: This mode allows you to see where pages will break when 

printed, and adjust them accordingly. 

To switch from one display mode to another: 

 Under the View tab in the Workbook Views group, click on the desired mode; 

 Or click on the display mode icons located in the status bar. 

Getting Help 

To get help in Excel for completing a specific task, press the F1 function key or click on the 

Help button (located at the top right of the Excel 2007 window). When the help dialog box 

appears, type in what you would like to do, then click the Search button. A list of topics 

related to your search will appear. Click on the topic of your choice to get explanations. 

Exiting Excel 2007 

Before exiting Excel, make sure you have saved your spreadsheet, then: 

 Click on the Office button to open the Office menu. 

 Click on Close. 

FIRST STEPS WITH EXCEL 2007 

Entering Data 

Excel allows you to quickly and easily enter data into your spreadsheet. The data you type 

will appear in the selected cell: 

 Type the data into the cell. Press Enter to move to the next cell in the column, or 

Tab to move to the next cell in the row. 

Selecting Data 

Most tasks in Excel require you to first select the data you want to work on. The selected data 

appears highlighted on the screen. There are several methods for selecting data: 

 Click and Drag: Point the mouse pointer at the first cell and drag the pointer over the 

data to select it. 

Selecting Data Based on Its Nature: 

 A cell: Click on it. 

 A row or column: Click on the row number or column letter. 

 A range of cells: Click on the first cell, then hold down the Shift key and click on the 

last cell. 

 The entire worksheet: Click on the Select All button (the small square at the 

intersection of the row numbers and column letters). 

To deselect data, click outside the selected area. 



Navigating a Spreadsheet 

Depending on the size of your spreadsheet and what you want to do, you may just want to 

"scroll" through the spreadsheet (leaving the active cell in place) or "navigate" within the 

spreadsheet (moving the active cell). The blinking box on the screen, called the active cell, 

indicates where the data you type will appear. 

 Scrolling through the spreadsheet (the active cell stays in place): 

o Mouse wheel; 
o The vertical and horizontal scroll bars. Drag their sliders or click the arrows 

to scroll. 

 Navigating within the spreadsheet (the active cell moves): 

o Click on one of the cells to make it the active cell. 

o The 4 arrow keys on the keyboard (Direction keys): → ← ↑ ↓ 

o Keyboard shortcuts: 
 Cell: To move to the next cell: Tab; to the previous cell: Shift + Tab 

 Row: To move to the next row: Enter; to the previous row: Shift + 

Enter 
 Worksheet: To move to the beginning of the worksheet: Ctrl + Home; 

to the end of the worksheet: Ctrl + End 

The other steps are the same as word (saving, printing,….) 

TP Office Automation (Practical) 

1. The Net 

Introduction to the Network 

A network refers to a collection of computers, servers, mainframes, network devices, or other 

devices connected to one another to allow the sharing of data and resources. Networks can be 

as small as two devices in a local area network (LAN) or millions of devices spread across the 

globe, forming a wide area network (WAN). 

Starting the Network 

To understand and utilize the network, you need to: 

 Ensure that your computer or device is connected to the network through an Ethernet 

cable or a wireless connection. 

 Open your Network settings to check for active connections and troubleshoot any 

connectivity issues. 

 Use network utilities and tools like ping, tracert, and nslookup to test and manage 

network connections. 

Network Elements 



 Router: A device that forwards data packets between computer networks, creating an 

overlay internetwork. 

 Switch: A device that connects devices within a local network, using MAC addresses 

to forward data to the correct destination. 

 Modem: A device that modulates and demodulates signals for internet access via 

telephone lines, cable, or satellite. 

 Firewall: A network security device that monitors and filters incoming and outgoing 

network traffic based on security rules. 

Command Buttons and Tools 

 Ping Command: Used to test the reachability of a host on an IP network. 

 Tracert Command: Determines the route data packets take to reach a network host. 

 Nslookup Command: Queries DNS to obtain domain name or IP address mapping. 

2. Internet 

Introduction to the Internet 

The Internet is a global network of billions of computers and other electronic devices. With 

the Internet, it's possible to access almost any information, communicate with anyone else in 

the world, and do much more. All of this is possible because of a standard set of protocols 

known as TCP/IP (Transmission Control Protocol/Internet Protocol). 

How to Start Using the Internet 

To start using the Internet, you need to: 

 Connect your device to an internet service provider (ISP) via a modem or router. 

 Open a web browser such as Google Chrome, Safari, or Mozilla Firefox. 

 Enter a URL (Uniform Resource Locator) in the browser’s address bar to navigate to a 

specific website. 

Internet Elements 

 Web Browser: A software application used to access information on the World Wide 

Web. 

 Search Engine: A service that allows users to search for content via the internet (e.g., 

Google, Bing). 

 Email: A method of exchanging digital messages over the Internet. 

 Social Media Platforms: Websites and applications that enable users to create and 

share content or participate in social networking. 

3. The Web 

Introduction to the Web 



The Web, also known as the World Wide Web (WWW), is a collection of websites or web 

pages stored on web servers and connected to local computers through the internet. These 

websites contain text, images, audio, and video, which users can access via web browsers. 

Starting to Use the Web 

To start using the Web, you need to: 

 Open a web browser. 

 Enter the URL of a website in the address bar to visit a specific site. 

 Use hyperlinks to navigate between web pages. 

Web Elements 

 Web Pages: Documents on the Web that can include text, images, videos, and 

hyperlinks. 

 Hyperlinks: Clickable links that direct you to other web pages or resources. 

 Web Servers: Computers that store and serve web pages to users. 

Command Buttons and Tools 

 Bookmark: Saves a web page for easy access later. 

 History: A record of web pages visited, allowing you to return to them easily. 

 Refresh Button: Reloads the current web page. 

4. Navigation 

Introduction to Navigation 

Navigating the internet involves using web browsers to visit websites, follow links, and move 

from one page to another. This is typically done by typing URLs into the browser's address 

bar or clicking on hyperlinks. 

Starting to Navigate 

To navigate the internet, you need to: 

 Open a web browser. 

 Use the address bar to enter URLs and visit specific websites. 

 Click on hyperlinks to move between pages. 

Navigation Elements 

 Address Bar: Where you type the URL of the website you want to visit. 

 Back and Forward Buttons: Allow you to go back to previously viewed pages or 

forward to pages you have navigated away from. 

 Home Button: Takes you back to your homepage. 

Command Buttons and Tools 



 Tab Management: Open, close, and switch between multiple web pages. 

 Zoom: Adjust the size of the web page content for better visibility. 

 Developer Tools: Inspect and debug web pages. 

5. Searching the Internet 

Introduction to Searching 

Searching the internet is a key skill for finding specific information. It involves using search 

engines like Google, Bing, or Yahoo to locate content based on keywords, phrases, or queries. 

Starting to Search 

To start searching the internet, you need to: 

 Open a web browser. 

 Navigate to a search engine website. 

 Enter keywords or phrases in the search bar and press Enter. 

Search Elements 

 Search Bar: The field where you type your search query. 

 Search Results: A list of web pages that match your query. 

 Filters: Options to narrow down search results by date, type, region, etc. 

Command Buttons and Tools 

 Quotation Marks (“”): Search for an exact phrase. 

 Minus Sign (-): Exclude certain words from the search. 

 Plus Sign (+): Ensure certain words are included in the search. 

6. Email 

Introduction to Email 

Email (electronic mail) is a method of exchanging digital messages between people using 

electronic devices. It operates across computer networks, primarily the internet. 

Starting to Use Email 

To start using email, you need to: 

 Create an email account with a service provider (e.g., Gmail, Outlook, Yahoo Mail). 

 Open your email client or web-based email service. 

 Compose and send messages to other email addresses. 

Email Elements 



 Inbox: Where received emails are stored. 

 Compose Button: Creates a new email message. 

 Sent Items: Stores emails you have sent. 

 Drafts: Stores unfinished emails. 

Command Buttons and Tools 

 Reply: Respond to the sender of the email. 

 Forward: Send the email to another recipient. 

 Attachments: Add files to your email message. 

 Search: Find specific emails within your mailbox. 

Common Icons in Word: French to English 

  Fichier = File 

  Ouvrir = Open 

  Enregistrer = Save 

  Enregistrer sous = Save As 

  Nouveau = New 

  Imprimer = Print 

  Aperçu avant impression = Print Preview 

  Fermer = Close 

  Quitter = Exit 

  Annuler = Undo 

  Rétablir = Redo 

  Couper = Cut 

  Copier = Copy 

  Coller = Paste 

  Sélectionner tout = Select All 

  Gras = Bold 

  Italique = Italic 



  Souligné = Underline 

  Barré = Strikethrough 

  Exposant = Superscript 

  Indice = Subscript 

  Couleur de police = Font Color 

  Couleur de surbrillance = Highlight Color 

  Aligner à gauche = Align Left 

  Aligner au centre = Center 

  Aligner à droite = Align Right 

  Justifier = Justify 

  Interligne = Line Spacing 

  Puces = Bullets 

  Numérotation = Numbering 

  Liste à plusieurs niveaux = Multilevel List 

  Retrait augmenté = Increase Indent 

  Retrait diminué = Decrease Indent 

  Bordures = Borders 

  Remplissage = Shading 

  Style de tableau = Table Style 

  Insertion = Insert 

  Image = Picture 

  Tableau = Table 

  Graphique = Chart 

  Lien hypertexte = Hyperlink 



  Texte en forme = WordArt 

  Zone de texte = Text Box 

  En-tête = Header 

  Pied de page = Footer 

  Numéro de page = Page Number 

  Orientation = Orientation 

  Marges = Margins 

  Format de page = Page Size 

  Colonnes = Columns 

  Saut de page = Page Break 

  Notes de bas de page = Footnotes 

  Commentaires = Comments 

  Révision = Review 

  Afficher/Masquer = Show/Hide 

  Fusionner les cellules = Merge Cells 

  Fractionner les cellules = Split Cells 

  Orthographe et grammaire = Spelling and Grammar 

  Suivi des modifications = Track Changes 

  Zoom = Zoom 

  Affichage en lecture = Reading View 

  Affichage normal = Normal View 

  Affichage page = Print Layout View 

 

 



Common Icons in Exel: French to English 

  Fichier = File 

  Ouvrir = Open 

  Enregistrer = Save 

  Enregistrer sous = Save As 

  Nouveau = New 

  Imprimer = Print 

  Aperçu avant impression = Print Preview 

  Fermer = Close 

  Quitter = Exit 

  Annuler = Undo 

  Rétablir = Redo 

  Couper = Cut 

  Copier = Copy 

  Coller = Paste 

  Sélectionner tout = Select All 

  Insérer = Insert 

  Supprimer = Delete 

  Rechercher = Find 

  Remplacer = Replace 

  Fusionner et centrer = Merge and Center 

  Insérer une ligne = Insert Row 

  Insérer une colonne = Insert Column 

  Supprimer une ligne = Delete Row 



  Supprimer une colonne = Delete Column 

  Tri croissant = Sort Ascending 

  Tri décroissant = Sort Descending 

  Filtrer = Filter 

  Mise en forme conditionnelle = Conditional Formatting 

  Format de cellule = Cell Format 

  Insérer un graphique = Insert Chart 

  Graphique = Chart 

  Tableaux = Tables 

  Ajouter un tableau = Insert Table 

  Style de tableau = Table Style 

  Feuille de calcul = Worksheet 

  Plage de cellules = Range 

  Valeurs = Values 

  Formules = Formulas 

  Fonction = Function 

  Référence = Reference 

  Nom de cellule = Cell Name 

  Calculer = Calculate 

  Actualiser = Refresh 

  Consolidation = Consolidate 

  Validation des données = Data Validation 

  Figer les volets = Freeze Panes 

  Fractionner = Split 



  Zoom = Zoom 

  Imprimer la sélection = Print Selection 

  Mise en page = Page Layout 

  Orientation = Orientation 

  Marges = Margins 

  Taille de la page = Page Size 

  En-tête et pied de page = Header and Footer 

  Filigrane = Watermark 

  Aperçu des sauts de page = Page Break Preview 

  Normal = Normal View 

  Mise en page = Page Layout View 

  Lignes de quadrillage = Gridlines 

  Volets = Panes 

  Mode plein écran = Full Screen Mode 

 


